Sequencer Scripts
4 May 2008
The Fta32 software includes the ability to run “user defined programs” on the instrument. These
might be called methods, but scripts are more general in nature. The user program is called a
script and the thing that runs or executes it is called the sequencer. It is entirely possible to run
the instrument without using scripts and, in fact, scripts do nothing except push buttons and fill
in text boxes the same way an operator can. Nevertheless the time investment in writing a script
is often worthwhile because
repetitive

operations become easy
may be manipulated so a large number of measurements are made
the script becomes documentation of the details of the method.
samples

Three Levels of Automation
You can always run the instrument in manual mode. This means you specify each basic
operation, like “move this axis 10mm to the right” or “analyze this image for contact angle”.
While the operation may be basic, it may also involve quite a bit of software work for one click
of a button, as is the case with image analysis. Manual mode is the most basic and historically
the oldest of the operating modes.
FTA provides a higher level of automation called macros. A macro is still a single click of a
button, but now this work may take an indefinite amount of time because image analysis will be
used to control stepper motor operation in a feedback loop. An example might be to hang a
certain volume pendant drop on a tip. The pump will be run until the desired volume is
achieved. This may take some time as, for example, there may not be any liquid in the line down
near the tip at the start. Or perhaps there is too much liquid in a drop at the start and the pump
has to retract volume. Macros are available for the basic operations necessary to make contact
angle and surface tension measurements. You can think of manual mode as specifying how to
do what you want done and macros as simply specifying what you want done.
The final and highest level of automation is the sequencer. The script is a program which can
perform ordinary manual mode operations, start macros and wait for their completion, and has its
own logic and counting structures to build a framework for complicated sequences.
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Script Attributes and Features
A script is stored in a single file (it happens to be an Access database) which can be stored
and loaded like any other file. You can have many scripts on disk.
It can be printed and it can be imported into a word processor. It is human readable.
Scripts are created and edited inside the Fta32 software by point-and-click operations. It is
not free-format writing as, say, with a word processor.
If you are careful, it can be exported as a text file, edited as a text file, and re-imported as a
script. When you edit externally, less error checking is available, but it is handy for “cut and
paste.”
There is no limit as to the size of the script.
Technically speaking, scripts are interpreted line by line as they execute. They are not
compiled. This makes debugging easier and on-the-fly changes possible. This is discussed
further below.

Basic Sequencer window with a script loaded.
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Editing Scripts
Scripts may be edited through simple commands. First we will illustrate editing an existing
instruction, which is one row or line in the table. We will choose to edit the third line, which
happens to be line number 10 in this example.

To edit: click in a row to select it, then click Edit Row. The details appear in the boxes in the middle.

When you Edit Row an existing row, all of the user changeable parameters appear in the text
boxes. You could, for example, change the line number (10) or the user variable comparison
value (0). The comment is your text description of what you are doing with this instruction.
When you finish, you can Cancel or Update Row the script with your new values.
To create a new instruction within the script, click New Row. Now you must fill in all of the
parameters before you Update Row. You can Cancel at any time. The main thing you must deal
with is selecting the instruction. This is done from the two drop down (pick) list boxes on the
left. The upper one is the instruction group or set. In the above figure, this is User Variables
and Macros. Within the selected group, the current instruction is User Variable if then. There
are many instructions, so they are grouped in sets to make finding them easier.
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After clicking New Row. The line number is automatically set to the next available line number, in
multiples of 10. You may well need a different line number, so you can edit this. The instruction set
selected is Program Control and the current instruction is No operation. You can click in these lists and
select any instruction you wish.

We will describe the instructions in more detail after we discuss running the Sequencer.

Running the Sequencer
Once you have a script prepared, you can run it one of two ways:
Start/full

speed: normal operation executing each instruction in turn as fast as possible.

Single

step: execute the next instruction and then stop. While stopped, you can do anything
you wish, including
performing manual motions or commands
executing macros
editing the script itself (yes!)
Start and Single Step are the ways you begin. You always begin at the first row, which will have
the smallest (positive) line number.
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If you are running full speed from a Start, you can Pause at the end of the current instruction.
From Pause, you can Resume normal full speed or Single Step or, if you wish to quit now, Quit.
After a Quit, you must start from the beginning next time.
From Single Step, you can again Single Step, Resume full speed, or Quit.
If you are in a paused or single step mode, you can edit the script at any line, but when you begin
again (either by Resume or Single Step), you resume at the next instruction you would normally
execute had you done no editing. You can not start again at any arbitrary instruction.
Single stepping is a good way to debug scripts because you can contemplate each instruction.
Normal full speed operation is too fast to follow with the eye. To help matters, these sequencer
run commands are available at the bottom of the drop down list on the Video tab. This lets you
watch the image as the instructions execute. All of this makes what is called an interactive
development environment.

Debugging Aids
The

Break instruction will pause the script. This lets the script run full speed until it gets to
the break. You can then inspect the system, edit the script, or do any other operation.
A

log is created of Sequencer events while running. All are date and time stamped. This
tells you when important things happened. The log is a text file which can be saved or
printed.
There

are instructions for writing your own message to the log file.

There

are instructions for stopping and asking the operator for a response. The script can
branch (do an if-then) based on the response.
You

can email scripts to FTA engineers and we will analyze them (we can run them) and
offer suggestions.

Loading Scripts
Scripts are “mdb” files, as are FTA Movies. To help you keep track of which files are scripts,
you may give them any valid file extension.
The Sequencer is available in all FTA1000 and FTA2000 configurations. These are selected on
the LogOn screen in the hardware choices section.
Scripts are loaded from File > Open Sequencer Program, as shown in the next figure.
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Preparing to load a script from disk. If you want a new, blank, script,
you can give it a valid filename in the dialog box which follows.

You make a copy of an existing script and give it a new name with File > Save Sequencer
Program As. This
leaves the old script as it was, and
makes a copy with the new name.
You then work on the new copy.
The “spreadsheet” like presentation of the script is called a grid. You can export the script to a
text file using File > Export Grid. You can then, if you choose, work with it in an editor. You
can import a text file back into the program as a script using File > Import Sequencer script. For
this to work correctly, the formatting present in the original exported file must be preserved. You
must have spaces in the right places and you must observe upper and lower case in text.
You can print the script, and any grid in the program, using File > Print Grid. Click in grid first.
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Scripts and FTA Instrument Models
The same Sequencer is available for all FTA instruments. However, it accomplishes little if the
instrument has no automation in the form of stepper motors.
A generic instruction like “Move X stage by 5mm” works on all instruments with a stepper
motor driven X stage. Scripts written for one instrument need only the “obvious” modifications
to reflect differences in generic hardware between the original and the newly targeted instrument.

Instruction Groups
The instruction groups are static, in contrast to the instructions within them which grow in
number in time as new features are added. The instruction group is selected by clicking in the
upper list, as shown below.

Drop down list for instruction groups. Use the scroll bar to access the complete list.
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Program Control: basic control over the script and what instruction is executed next are in this
group. Specialty instructions such as Break, No operation, and Quit are here. No operation is
used as a placeholder and is convenient for including extra comments. Various waiting
statements are provided so the script will simply delay some time before proceeding. Calls to
subroutines and loop setups are included here. Subroutines are separate pieces of code that you
wish to execute at this time but which are located elsewhere for convenience. A simple example
would be to have two separate subroutines for contact angle analysis and to choose which to use
by calling the desired subroutine. Loops let you do some body of code repetitively. You can
have up to 100 independent loops. You can have an indefinite number of subroutines. This
group also includes messages to the operator while running and branches on their response.
Stage Moves: control over specimen stage and tilt stage movements are here. Manual stage
movements are either a Home to a sensor at one excursion limit or an incremental Move by from
the current position. Scripts also provide a Move to which is a move from wherever you are to
the specified target. You need to keep in mind which type of move you are using. Incremental
moves are particularly convenient within loops and subroutines: “move over 5 mm from where
you are right now.” Use these in step and repeat loops.
Liquid Dispense, Autosampler, Tip Z: liquid dispense operations are here. Tip Z and
autosampler motions are also here. While they might seem like a “stage move”, they are
separated from the above specimen stage moves because these are concerned with getting liquid
to some desired position.
Video and Movie Capture: camera and image capture control are in this group. Note you must
use the Open Movie instruction to connect the Sequencer to a newly captured movie. This is
because there could be other movies open on the screen and the new one must be identified.
When you finish, you must have an explicit Close Movie to break the connection.
Movie Analysis: all analysis functions on the opened movie are in this group.
Names, Files, Databases: this is a catch-all group for assigning names and opening and closing
files.
Data Cells: cells are sets of data which you wish to group together, typically for surface energy
analysis, where a number of drops contribute to the surface energy of one “point.” Think of that
point as a cell.
Chambers: chambers and temperature and relative humidity measurements are in this group.
The necessary sensors must be installed on your instrument.
User Variables and Macros: user variables can be assigned data by analysis functions or by the
script itself. You can then branch on their value. Macros are real time feedback functions that
use image analysis to drive stepper motors to some target.
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Example Script
The following script was Edit > Copy Grid and then pasted into this word processing program.
To make it format nicely, it required changing the font and size and reseting tabs.
Line
1
2
10
11
12
13
20
30
40
100
105
110
111
120
121
190
200
210
290
299
400
410
420
425
430
435
440
450
451
455
460
470
475
495
500
505
510
515
520

Operation
No operation
No operation
User Variable if then
Call subroutine
Call subroutine
Set User Variable value
Home Kloehn pump
Move Z to
Move tip Z to
Begin loop
Call subroutine
Call subroutine
No operation
Call subroutine
No operation
End loop
Home tip Z'
Home Z stage
Message box
Quit
No operation
Open movie
Use previous baseline
Reflection image type baseline
Spherical mode analysis
Contact angle baseline
Do contact angle measurement
Close movie
Video
No operation
Move Tip Z to target
Syringe pump volume, rate
Move tip Z by
Return subroutine
No operation
Syringe pump volume, rate
Video
Position tip in image
Find potential baseline

Parameters

525
530
535
590
600
610
620
630
631
633
634
640

Dispense volume
Touch off drop
Snap shot
Return subroutine
No operation
No operation
Open movie
No operation
Use previous baseline
Reflection image type baseline
Spherical mode analysis
No operation

3
.05

1; 0; 20
900
800
1; 1
29.5
-45
3; 4
820
500
400

Comment
Contact angle program for FTA1000
Keep track of changes here...
Test var #1 for greater than 0 (var initialized to 0)
Call home routine (once per session)
Movie setup routine
Will cause if/then to execute only once
Home pump each time you start --> plenty of liquid
Critical height: set as req'd (see also line 950)
May require adjustment
Do 4 points
Position stage at desired well
Dispense and capture Snapshot
Use subroutine at 700 for a full Movie
SnapShot analysis
Use 600 for full Movie analysis

3
Clean up at end
All done!
5
1
1
1

Inform user
All done
SnapShot analysis
Must have this...
Need this
This is a guess, but likely
Best choice for smaller drops
Leave parameters blank to use Macro's data
Finally
Need this

1
.05
-3; 3
1.5
-2; 1
1
25

15
1
1
1

Do pickup here
Down to surface
Go up
Dispense liquid and capture SnapShot
Clear tip of any liquid
Ensure on
Macro to put tip in top of image
Macro to move tip down, then up, to establish
baseline
Macro to form fixed drop
Macro to touch off drop; go extra 50um
Grab it
Movie analysis
Could use SnapShot here instead of earlier Run
Must have Open/Close Movie pair
Set analysis parameters
This default should be on (checked)
Normal case
You may prefer non-spherical mode
Move to first valid image (depends on Capture
values)
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641
642
643
644
645

Move to first image in movie
Begin loop
Move to next image in movie
End loop
Contact angle baseline

646

No operation

647
650
651
652
654
655
670
680
690
700
710
720

No operation
Begin loop
Do contact angle measurement
Move to next image in movie
Wait time
End loop
Close movie
Status info
Return subroutine
No operation
Syringe pump volume, rate
Video

721
722
723
730
740
750
OK)
751
760

Pretrigger images
Posttrigger images
No operation
Position tip in image
Find potential baseline
Dispense volume

5; .033
20; .1; 1.05

Start pump on run
Run

0

770
790
800
801
805

Touch off drop
Return subroutine
No operation
No operation
Save movies as

-0.05

810
820
830
831
832
833
834
840
841
842
843
850
851
852
853
860
861
862
863
870
871
872
873
900

Return subroutine
No operation
Loop if then
Loop if then
Loop if then
Loop if then
Return subroutine
No operation
Move X to
Move Y to
Return subroutine
No operation
Move X to
Move Y to
Return subroutine
No operation
Move X to
Move Y to
Return subroutine
No operation
Move X to
Move Y to
Return subroutine
No operation

1; 8

Loop #1 will skip to image #9

1

2; 16

Leave parameters blank to now use Macros'
baseline
'C.A. baseline' must be set with target image
present
therefore move to desired Movie image first
Loop #2 do rest of images in Movie (see Capture)
Makes actual measurement

2
2

So user can inspect (could eliminate)

All done!

Could write something to log...

-2; 1
1

25
5

Dispense liquid and capture multiple image Movie
Pull in 2ul at 1ul/s to clear tip
Setup Movie capture (you may prefer other
values)
To show touch-off
Total time 3.3s (you can change values)
Trigger will be provided by Touch-Off Macro
Macro to put tip in top of image
Macro to find baseline from image
Macro to form 5ul pendant drop (other volumes
No additional pump run
Starts Movie acquisition; could also use SnapShot
later
Actual touch off; go down extra 50um

Setup saving movies; directory must make sense
Enter folder and basic file name you want
C:\Temp\CA_DataMovie.mdb;
0 or no suffix = autoincrement within session
3; 3; 870
3; 2; 860
3; 1; 850
3; 0; 840

Table to go to 4 random locations
Go to point 4
Go to point 3
Go to point 2
Go to point 1
Should not get here; this is for safety
Absolute move to first point

23.629
-35.364
Absolute move to second point
23.629
35.364
Absolute move to third point
-23.355
-35.364
Absolute move to fourth point
-27.128
27.128
Optional homing routine
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901
910
920
930
940
941
942
943
944
950
951

No operation
Home Z stage
Home Y stage
Home X stage
Home tip rack
Move tip to video position
No operation
No operation
No operation
Move Z by
No operation

970

Question

975

Message box

976
990

Break point
Return subroutine

We use home offsets to "zero" X and Y
Do before Y to get Z low

You must have correct values on Pump tab
Now have positioned tip over fiduciary mark
Assume it is center of wafer
We will measure from this "origin"
30
Move stage up near needle; adjust as req'd
You must get sample to reasonable Z position
here!
Is tip over target mark?; 990; 975
User must validate alignment here, once
Click OK to close this box: then move specimen (using Stage Move
commands and set X=0: Y=0) till correct: then click Resume to go on.
Sequencer pauses until user clicks Resume

What does this script do?
Line

10 is a test of a user variable (#0 in this case) to see if it has been set to a value greater
than 0. By convention, all variables start out with value zero. The purpose of this is to see if
this is the first time the script has run in this Fta32 session. User variables are “static”
meaning they are remembered for as long as the program is running. Being the first time, the
test fails and the script moves to the next instruction, which happens to be line 11. It will
then go and home the instrument by a call to subroutine 900. When it gets to line 13, it sets
this #0 user variable to the value “1” so the next time the test will be satisfied. When
satisfied, the test jumps to the specified line number, which happens to be “20”.
Lines

900 through 990 take care of homing the stages for this application. You may well
wish to change some aspects of this routine. The message box at line 975 asks the operator
whether the tip is positioned correctly. If not, the operator could move the stage manually at
this point since the Sequencer is in a break. When all is well, the operator clicks Resume and
the script continues.
Lines

800 through 810 are a short routine to set the base name for saved movies. Each
movie will have this base name plus a numeric suffix which indexes by 1 each movie. The
suffix number is static so it can continue to increment as long as the Fta32 program is
running (not just for one execution of the script).
Lines

20 through 40 take care of some housekeeping we want to do every time the script
executes, unlike the homing which we do just once.
Lines

100 through 190 are the fundamental loop for this script. This loop is given the name
3. It has a Begin loop and an End loop which act as “bookends” for the loop. The script will
cycle back from line 190 to 100 four times because of the loop count parameter 4. This
script will simply put down four drops and analyze them, but you can have loops inside of
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loops in order to create complicated patterns of drops.
Within

the fundamental loop, there is a call to subroutine lines 820 through 834 which
move the specimen stage to four arbitrary positions. A simple “move over X” in this routine
would give you a row of drops. Lines 830 through 833 have Loop if then instructions. These
are setup, in this case, to test the loop count of the loop called 3. If this is the first time
through this loop, only line 833 will be satisfied and the script will call the subroutine at line
840 to do the actual X-Y move. Since the parameters for these moves are explicit and
arbitrary, the stage can be sent anywhere.
After

the stage is positioned, we call the subroutine at lines 500 through 590 to form a drop,
touch it off on the sample and take a SnapShot of the drop. Starting with line 515, we use
four macros in a row:
Position

tip in image will move the Tip Z axis so the tip is, in this case, 25 pixels down
from the top. This is about 5% of the 640x480 pixel image.
Find

potential baseline will probe the surface by moving the dry tip down close and
observing the image to figure out where the surface is. This location may be used later
by the contact angle analysis to set the baseline.
Dispense

volume runs the pump to form, in this case, a pendant drop of 3 microliters.

Touch

off drop lowers the Tip Z in such a fashion that the bottom of the liquid drop just
touches the surface. The tip is then raised and the drop will normally break free from the
tip. The 0.05mm parameter is extra down motion to make sure the drop adheres to the
specimen.
After

capturing an image of the sessile drop on the surface, subroutine lines 400 through
495 perform a contact angle analysis. Notice the Open movie (line 410) and Close movie
(450) pair. This routine also attempts to pickup the liquid on the surface. It is not possible to
remove 100% of the liquid, but most can be removed. This is handy if you are placing drops
close to one another and you worry about the old ones appearing in the newer one's images.
Lines

600 through 690 alternatively analyze a full movie rather than just a snap shot.

Lines

700 through 790 alternatively deposit drops and capture a full movie rather than just a
snap shot.
To

use the alternative formats, you would change the calls at lines 110 and 120.
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Instruction Listing: Program Control
A <...> indicates you fill in a number or some text in the edit box. Instructions are shown in the
approximate order they appear in the drop down list on the Sequencer tab.
Program Control
Instruction

Parameters

Description

Go to line

Go to line number: <line number>

Jump to the line number in the
program. An invalid line number
will create an error. Line
numbers are always positive
integers. You can think of line
numbers as labels for
instructions.
This instruction does nothing.
Instead its place in the program
allows the user to add comments
or save a line number.
Ordinary Sequencer operation
will stop at this point. This is
useful for debugging. You can
start the Sequencer again by
clicking Resume.
Conclude Sequencer operation
with this instruction. You will
then Start over later.
Wait here for the indicated
number of seconds. You can
wait any positive length of time
measured in seconds. A
fractional second is OK.
Wait here for an “OK” from an
external controller or robot. If a
non-zero time is provided, wait
up to this time, otherwise wait
forever.

No operation

Break point

Quit
Wait time

Wait time: <seconds>

Wait for external device

Wait time (0…60s): <seconds>

On timeout or error go to: <line number>

Begin loop

Loop number (1…100): <index>

Loop count: <count>

If there is a timeout, or the
external device sends an error
message (for example, it has
stalled), go to the line provided.
If no line, then do not go
anywhere.
Starts a loop. Up to 100 loops
can be defined. Each is given a
unique index number by user.
There will be a mating End loop
for each Begin loop.
How many loops to do. An
integer greater than zero. Upper
limit is 231.
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Program Control
Instruction

Parameters

Description

Loop if then

Loop number (1…100): <index>

The if/then test refers to this
loop. This lets you branch on
the loop iteration count. The
loop count starts at 0 and is
incremented (say to 1) by the
End Loop instruction after the
loop is completed.

If loop count: <count)

If the loop count of the selected
loop is equal to the user set
target, then do the go to.

Go to line number: <line number>
Loop number (1…100): <index>

Jump to this line if test satisfied.
The if/then test refers to this
loop. This lets you call a
subroutine based on the loop
iteration count.

If loop count: <count)

If the loop count of the selected
loop is equal to the user set
target, then call the subroutine.

End loop

Subroutine line number: <line number>
Loop number (1..100): <index>

Call subroutine

Subroutine line number: <line number>

Jump to this line if test satisfied.
This line ends the selected loop.
It increments the loop counter.
Jump to the indicated line
number to start a subroutine.
When you return from the
subroutine, you will go to the line
following this call. There must
be a mating return subroutine
instruction for each call.
Program flow returns to the
instruction following the original
call instruction.
Message to output to event log.
Turns run time log on or off.
This question allows the user to
direct the program flow in one
direction or another at some
critical point. This text is the
question to appear in a dialog
box.

Loop if then subroutine

Return subroutine
Status info
Sequencer run log
Question

Status message: <user text>
On=1, Off=0: <0 or 1>
Question message: <user text>

If “Yes” GoTo line” <line number>

Jump to this line if user answers
yes to the question.

If “No” GoTo line: <line number>

Jump to this line if the user
answers no to the question.
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Program Control
Instruction

Parameters

Description

Message box

User message: <user text>

Message user variable

User variable number: <index>

This is a simple message
presented to the user in a dialog
box. The only response is OK.
The value of the chosen user
variable (index typically 1...200)
will be given to operator in a
dialog box. The only response is
OK.
Switch to the Video tab. Useful
to force the image to be visible
to operator.
Switch to the Sequencer tab.
Normally each motor motion is
completed before the Sequencer
goes to the next instruction.
This instruction starts a period
when the Sequencer will
continue with its next instruction
before the motion started with
this or a previous instruction is
complete. The intended use is
with tilt axis motions for tilting
plate contact angle
measurements.
Return to the normal mode of
waiting for each motor motion to
complete before moving to the
next instruction.

Show video
Show sequencer
Begin no waiting for
motion end

End no waiting for
motion end
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Instruction Listing: Stage Moves
Not all instructions will be available for any particular instrument. You will have the
instructions appropriate to your configuration.
Stage Moves
Instruction

Parameters

Description

Move tilt by

Move by (deg): <angle to increment>

Move the motor by the specified
increment at the rate. This is a
relative move from the current
position.
Move the motor to a specific
target location at the rate. It is
OK if the motor is already there.
Move the motor by the specified
increment at the rate. Similar to
the above except that the
Sequencer will not wait until the
move is finished, but will go on
to the next instruction.
Move the motor to a specific
target location at the rate.
Similar to the above except that
the Sequencer will not wait until
the move is finished, but will go
on to the next instruction
Home the tilt stage.
Move the motor to a specific
target location. It is OK if the
motor is already there.
Move the motor by the specified
increment. This is a relative
move from the current position.
Make a random Z move. Limited
to +/-1mm from current position.
Useful for testing.
Move the motor to a specific
target location. It is OK if the
motor is already there.
Move the motor by the specified
increment. This is a relative
move from the current position.
Move the motor to a specific
target location. It is OK if the
motor is already there.
Move the motor by the specified
increment. This is a relative
move from the current position.
Home the X axis stage.

Rate (deg/s): <tilt rate>
Move tilt to

Move to (deg): <angle>

Move tilt by, no wait

Rate (deg/s): <tilt rate>
Move by (deg): <angle to increment>
Rate (deg/s): <tilt rate>

Move tilt to, no wait

Move to (deg): <angle>
Rate (deg/s): <tilt rate>

Home tilt stage
Move Z to

Move to (mm): <Z target mm>

Move Z by

Move by (mm): <Z increment mm>

Random (1mm) stage Z
move
Move X to

Move to (mm): <X target mm>

Move X by

Move by (mm): <X increment mm>

Move Y to

Move to (mm): <Y target mm>

Move Y by

Move by (mm): <Y increment mm>

Home X stage
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Stage Moves
Instruction

Parameters

Home Y stage
Home Z stage
Move R (radial) to

Move to (mm): <R target mm>

Move R (radial) by

Move by (mm): <R increment mm>

Move Q (theta) to

Move to (deg): <Q target degrees>

Move Q (theta) by

Move by (deg): <Q increment degrees>

Move XY by

Move X by (mm): <X increment mm>
Move Y by (mm): <Y increment mm>

Home R (radial) stage
Home Q (theta) stage
Home Z stage
Move external device

Parameter 0: <user text>
Parameter 1: <user text>
Parameter 2: <user text>

Home cylindrical X stage
Home cylindrical rotation
stage
Move cylindrical X by

Move by (mm): <X increment mm>

Move cylindrical rotation
by

Move by (deg): <rotation increment
degrees>

Description
Home the Y axis stage.
Home the Z axis stage.
Move the motor to a specific
target location. It is OK if the
motor is already there.
Move the motor by the specified
increment. This is a relative
move from the current position.
Move the motor to a specific
target location. It is OK if the
motor is already there.
Move the motor by the specified
increment. This is a relative
move from the current position.
This instruction allows the Rtheta stage to behave like an XY stage. The motions must be
increments from the current
position.
Home the radial axis stage.
Home the theta (rotation) axis
stage.
Home the Z axis stage.
This instruction will send up to
three user text strings to the
external robot. The text has no
meaning to the Sequencer but
does have meaning presumably
to the robot.
Home the X axis of the
cylindrical stage (coffee can
stage).
Home the rotation axis of the
cylindrical stage
Move the motor by the specified
increment. This is a relative
move from the current position.
Move the motor by the specified
increment. This is a relative
move from the current position.
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Instruction Listing: Liquid Dispense, Autosampler, Tip Z
Not all instructions will be available for any particular instrument.
Liquid Dispense, Autosampler, Tip Z
Instruction
Parameters
Home autosampler
Home tip Z’s
Liquid index

Set test liquid index: <index number>

Inlet solenoid valve

Open=1, Closed=0: <0 or 1>

Outlet solenoid valve

Open=1, Closed=0: <0 or 1>

Valve position

Tip=1, Vial=0: <0 or 1>

Valve to tip

Connect pump to tip: <1, 2… 6>

Pump volume, rate

Pump volume (ul): <dispense volume>

Pump rate (ul/s): <dispense rate>

Description
FTA2000: Home autosampler;
this is a “home all”.
Bring all tip Z axes up to top.
Set the index number for the test
liquid. This refers to the row
number in the current Liquids
database. This will provide
specific gravity information to
IFT measurements.
FTA2000: Manually force the
inlet valve to the pump to be
open (1) or closed (0). The inlet
valve sits between the system
liquid bottle and the pump. For
most operation, this valve is
closed. This instruction checks
or unchecks the checkbox of the
same name on the Pump |
Autosampler tab.
FTA2000: Manually force the
outlet valve to the pump to be
open (1) or closed (0). The
outlet valve sits between the
pump and the dispense tips.
For most operation, this valve is
closed. This instruction checks
or unchecks the checkbox of the
same name on the Pump |
Autosampler tab.
FTA1000: Send Kloehn valve to
indicated position.
FTA2000: This instruction
moves the Hamilton distribution
valve to one of the six tips. The
pump is then connected to a
specific tip.
FTA2000: Move the pump so as
to dispense (towards a more
positive volume) or aspirate
(towards a more negative
volume).
Excessive rates, above 20
microliters per second, will
cause air bubbles to form in the
system liquid.
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Liquid Dispense, Autosampler, Tip Z
Instruction
Parameters
Syringe pump volume,
rate

Pump volume (ul): <dispense volume>
Pump rate (ul/s): <dispense rate>

Select tip for move

Set tip to use: <selected tip>

Home Kloehn pump
Tip to vial

Set vial: <target vial>

Tip to video

Set tip to use: <selected tip>

Move tip Z to

Move tip Z to (mm): <Z target mm>

Move tip Z by

Move tip Z by (mm): <Z increment mm>

Move tip rack X by

Increment (mm): <X distance mm>

Move tip to video
position
Move tips up
Home tip rack
Tip Z slow

Normal=0, Slow=1 <0 or 1>

Description
FTA1000: Move the pump so as
to dispense (towards a more
positive volume) or aspirate
(towards a more negative
volume). Excessive rates,
above 20 microliters per second,
will cause air bubbles to form in
the system liquid.
Selected tip will be used for
future pump or tip Z moves.
FTA1000: Home Kloehn pump.
Required before first move in a
session.
FTA2000: Move the selected tip
to the specified vial. The tip is
then the one which will be
moved up or down with
subsequent Tip Z moves. If you
want to change the selected, or
current, tip, do a Tip to vial or a
Tip to video move, even if the tip
in question is already at that
location. this will make it the
current tip.
Move the selected tip to the
video position. The tip is then
the one which will be moved up
or down with subsequent Tip Z
moves.
Move the current tip to a specific
Z height. The upper most
position is 0. All target positions
are below this, so they are
negative.
Move the current tip by the
specified Z increment. This
moves an additional amount
rather than to a specific position.
FTA1000: Move tip rack by
increment.
FTA1000: Move current
selected tip to video position.
FTA1000: Move all tips high.
Same action as Home Tip Z's.
FTA1000: Home tip rack. Also
homes tip Z's.
FTA2000: Vary tip Z speed for
touch-offs with less drop
vibration.
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Liquid Dispense, Autosampler, Tip Z
Instruction
Parameters
Prime towards tips

Prime in volume (ul): <volume>

Prime from tips

Prime out volume (ul): <volume>

Drop tip

Pickup new tip

Require tips high before
rotate
Plate 1 first active alpha
row

First alpha row: <A, B....>

Plate 1 last active alpha
row

Last alpha row: <...G, H>

Plate 1 first active
numeric col

First numeric column: <1, 2...>

Plate 1 last active
numeric col

Last numeric column: <...11, 12>

Plate 2 first active alpha
row

First alpha row: <A, B....>

Plate 2 last active alpha
row

Last alpha row: <...G, H>

Description
FTA2000: Carry out a prime in
sequence from the system vial.
This will move liquid towards the
dispense tips.
FTA2000: Carry out a prime out
sequence away from the tips
This will move liquid towards the
dispense tips.
FTA2000: For systems with the
automatic tip changer, discard
the dispense tip from the active
tip.
FTA2000: For systems with the
automatic tip changer, pickup a
new dispense tip on the active
tip. The tip storage wheel will
advance automatically to the
next position.
FTA2000: Require that tip Z's
be high before carousel move.
Tips will be moved if necessary.
FTA1000: First active
alphabetic row on plate 1.
Allows you to ignore some initial
rows.
FTA1000: Last active
alphabetic row on plate 1.
Allows you to ignore some final
rows. Available rows depend on
pitch entered on tab (e.g., 9mm).
FTA1000: First active numeric
column on plate 1. Allows you
to ignore some initial columns.
FTA1000: Last active numeric
column on plate 1. Allows you
to ignore some final columns.
Available columns depend on
pitch entered on tab (e.g., 9mm).
FTA1000: First active
alphabetic row on plate 2.
Allows you to ignore some initial
rows.
FTA1000: Last active
alphabetic row on plate 2.
Allows you to ignore some final
rows. Available rows depend on
pitch entered on tab (e.g., 9mm).
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Liquid Dispense, Autosampler, Tip Z
Instruction
Parameters
Plate 2 first active
numeric col

First numeric column: <1, 2...>

Plate 2 last active
numeric col

Last numeric column: <...11, 12>

Move autosampler Y by

Increment (mm): <X increment mm>

Home autosampler tray
Move tip to P1 XY
Move tip to P1 XYZ
Move tip to P2 XY
Move tip to P2 XYZ
Move tip to waste XY
Move tip to waste XYZ
Move tip to tip hook XY
Move tip to tip hook XYZ

Detach tip

Set P1 target to first
position

Description
FTA1000: First active numeric
column on plate 2. Allows you
to ignore some initial columns.
FTA1000: Last active numeric
column on plate 2. Allows you
to ignore some final columns.
Available columns depend on
pitch entered on tab (e.g., 9mm).
FTA1000: Move autosampler by
increment. The vial tray moves
in the Y direction, parallel to the
microscope's optical axis.
FTA1000: Home the
autosampler vial tray.
FTA1000: Move current tip to
target XY position over plate 1.
No tip Z motion.
FTA1000: Move current tip to
target XYZ position over plate 1.
FTA1000: Move current tip to
target XY position over plate 2.
No tip Z motion.
FTA1000: Move current tip to
target XYZ position over plate 2.
FTA1000: Move current tip to
waste XY position.
FTA1000: Move current tip to
waste XYZ position. You can
discharge waste liquid here.
FTA1000: Move current tip to
detachment XY position.
FTA1000: Move current tip to
detachment XYZ position. This
instruction is mainly for setup
purposes to test the XYZ values
entered on the autosampler tab.
FTA1000: Performs the
complete XYZ move sequence
to detach a tip. Tips are
attached by driving the bare
Luer hub down into an available
tip in the plate's XY matrix, The
vial tray must be setup to hold
new tips, as opposed to vials or
a plate.
FTA1000: Set the current
autosampler target for plate 1 to
the first active position.
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Liquid Dispense, Autosampler, Tip Z
Instruction
Parameters
Increment P1 target

Set P2 target to first
position
Increment P2 target

Home current tip Z

Home tip X rack only

Description
FTA1000: Increment the current
autosampler to the next plate 1
available position. This will wrap
around to the first position after
the last position is reached.
FTA1000: Set the current
autosampler target for plate 2 to
the first active position.
FTA1000: Increment the current
autosampler to the next plate 2
available position. This will wrap
around to the first position after
the last position is reached.
FTA1000: Home only the current
selected tip Z. Note that “current
pump” and “current tip” are the
same and are chosen by
checkboxes.
FTA1000: Home the tip X rack
only. You should make sure the
tips are high enough that they
will not hit anything.
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Instruction Listing: Video and Movie Capture
Video and Movie Capture
Instruction
Parameters
Snap shot
Run

Trigger on Run start

On=1, Off=0: <0 or 1>

Tilt on Run start

On=1, Off=0: <0 or 1>

Restart Video after
Movie

True=1, False=0: <0 or 1>

Video

On=1, Off=0: <0 or 1>

Back light

On=1, Off=0: <0 or 1>

Front light

On=1, Off=0: <0 or 1>

Increment Live video
brightness

Increment brightness by: <value>

Increment Live video
contrast

Increment contrast by: <value>

Pretrigger images

Pretrigger images: <image count>
Pretrigger image period (s): <period>

Description
Capture a single-image Movie
now.
Start the capture of a multiple
image movie. This Movie must
have a Trigger event to
complete.
Automatically generate a Trigger
as soon as Run starts to capture
a Movie.
Start a tilt motion when the Run
starts (if a stage is present and a
tilt increment specified).
If set = 0, the Video will not be
restarted automatically when the
captured Movie is closed. If this
instruction is not used, Video will
be restarted after a Movie. If set
= 1, it will also be restarted.
Turn on or off the Video
checkbox on the Live Video tab.
Video must be turned on to get a
live image.
Turn on or off the back light.
The back light will normally be
turned on automatically when
Video is started. The back light
is the one used to illuminate
normal analysis images.
Turn on or off the front light (if it
exists). This is used for
observing the general nature of
the sample better.
Brightness can be vary from 0 to
100. This will change the current
brightness setting, but will stay
within 0...100.
Contrast can be vary from 0 to
100. This will change the current
contrast setting, but will stay
within 0...100.
Setup the number and period of
images before the Trigger in a
multi-image Movie. These
entries are just like those on the
Capture tab.
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Video and Movie Capture
Instruction
Parameters
Posttrigger images

Posttrigger images: <image count>
Posttrigger image period (s): <period>
Posttrigger period multiplier: <factor>

Video trigger by gray
level

On=1, Off=0: <0 or 1>
X coordinate (pixels): <position>
Y coordinate (pixels): <position>

Video trigger by gray
change

On=1, Off=0: <0 or 1>
X coordinate (pixels): <position>
Y coordinate (pixels): <position>

Trigger on pump done

On=1, Off=0: <0 or 1>

Start pump on run

On=1, Off=0: <0 or 1>

Stop pump on trigger

On=1, Off=0: <0 or 1>

Do pump program on
run

On=1, Off=0: <0 or 1>

Trigger

Description
Setup the number and period of
images after the Trigger in a
multi-image Movie. These
entries are just like those on the
Capture tab. The post-trigger
multiplier should be 1 unless
you want the period to gradually
increase after each image, in
which case it should be slightly
greater than 1, say 1.05.
Turn on or off the Video Trigger
by Z < 120 checkbox on the
Capture tab. If enabled, a
cross-hairs will be placed in the
image. If the gray scale of the
image is darker than mid-gray, it
will cause a Trigger.
Turn on or off the Video Trigger
by Z < 120 checkbox on the
Capture tab. If enabled, a
cross-hairs will be placed in the
image. If the gray scale of the
image is darker than mid-gray, it
will cause a Trigger.
Turn on or off the Trigger at
Pump Completion checkbox on
the Capture tab. If enabled, a
Trigger will be generated when
the pump finishes its motion.
If 1, start the pump when a Run
is started. This will set the
similarly named checkbox on
the Pump | Syringe tab, if this
tab is visible to the user.
If 1, stop the pump whenever a
Trigger occurs. This will set the
similarly named checkbox on
the Pump | Syringe tab, if this
tab is visible to the user.
If 1, start the pump program
when a run starts. This will set
the similarly named checkbox
on the Pump | Syringe tab, if this
tab is visible to the user.
Trigger the Movie now, without
any condition.
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Video and Movie Capture
Instruction
Parameters
Open movie

Max time to wait (s): <seconds>

Close movie

Open last movie

Close last movie
Autofocus

Zoom position

Zoom position (steps): <position>

Zoom step by

Step Zoom by: <increment>

Focus position

Focus position (steps): <position>

Focus step by

Focus index: <increment>

Description
You must Open Movie after the
movie is captured and before
any analysis can be performed
or reference to the Movie made.
This instruction connects the
two screens in Windows. The
timeout parameter lets you
establish a maximum time to
wait for the Movie to be ready
for opening. If you specify no
time, then the instruction will
wait as long as necessary for
the Movie to be captured and
ready. If, for example, no
trigger ever occurs, then the
Open Movie instruction (without
a timeout) will never complete
and the Sequencer program will
hang.
All Movies, including
SnapShots, must be Closed
before you can move on to
capturing another Movie. The
Movie is saved to a disk file at
this time.
There are times it is useful to
open the previous Movie for
analysis. This instruction does
that.
This instruction Closes any
previous Movie you opened.
This instruction carries out an
Autofocus sweep. You must
setup the details of the sweep
on the Analysis | Auto
Zoom/Focus tab. The
Autofocus routine takes a
minute or so to execute.
Move the zoom (magnification)
motor to the specified position.
Zero steps is the position of
lowest magnification.
Move the zoom motor by the
increment from its current
position.
Move the focus motor to the
specified position.
Move the focus motor by the
increment from its current
position.
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Video and Movie Capture
Instruction
Parameters
Home Zoom
Home Focus

Description
Home zoom motor. Leaves
zoom at minimum magnification
(largest field of view).
Home focus motor. Leaves
focus at farthest focal plane
from microscope.
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Instruction Listing: Movie Analysis
Movie Analysis
Instruction

Parameters

Description

ROI upper left point

Upper left X (pixels): <position>

You may specify a Region of
Interest box for analysis. The
analysis will ignore anything
outside the box. Move the cursor
over the image and read the X
and Y values in the lower status
bar. The origin (0, 0) is in the
upper left hand corner of the
image.
This is the lower right hand
corner for the ROI box.
You may specify a starting
baseline for contact angle
measurements. The final line
will be an extension of this line.
The specified line must be
horizontal, hence there is one
common Y value. Move the
cursor over the image and read
the X and Y values in the lower
status bar. The origin (0, 0) is in
the upper left hand corner of the
image.

Upper left Y (pixels): <position>

ROI lower right
Contact angle baseline

Lower right X (pixels): <position>
Lower right Y (pixels): <position>
Left X (pixels); <position>
Right X (pixels): <position>
Y (pixels): <position>

Contact angle
measurement set

Contact angle set number (1..6):
<index>

Index contact angle set
Do contact angle
measurement
Data limits

Lower limit: <value>
Upper limit: <value>

If you use the Find Potential
Baseline macro, include this
instruction in your script but
leave the parameters blank to
indicate you want to use the
macro's data.
Contact angle measurements
can be grouped into sets. Up to
6 sets can be defined. This sets
the index (numeric label) of the
current set.
Increment the contact angle set
index (ID number) by one.
Make a contact angle
measurement on the current
image in the Movie.
Contact Angle and IFT
measurements may be checked
by applying limits to their value.
Data that fail are not included in
the output set.
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Movie Analysis
Instruction

Parameters

Description

Baseline tilt limit

Limit: <degrees>

Left-right angle limit

Limit: <degrees>

Edge sensitivity

Edge sensitivity (0..100%): <sensitivity>

Simulation data

Mean value data: <value>

Contact angle data taken with
tilting baselines allowed may be
checked by applying a limit to
the tilt. A reasonable value is 5
degrees. Angles that fail are not
included in the output data set.
Contact angle data taken in nonspherical mode may be checked
by applying a limit to the
difference between the left and
right angles. A reasonable value
would be 2 or 3 degrees. Angles
that fail are not included in the
output data set.
Edge Sensitivity is a user
parameter to adjust how the
analysis handles imperfect drop
profiles. It is normally left at the
default 50%. A lower number
will make the analysis more
tolerant of imperfections or poor
image quality. A higher number
will make it less tolerant.
You can simulate data to
generate output files when no
instrument is connected. This
instruction will generate data in
place of a Contact Angle or IFT
measurement. The data can be
pseudo-random by adding a
varying amount according to the
variance specified. Zero
variance makes the data
precisely equal to the mean
value specified. You enable the
simulation mode by having
unchecking the Enable Camera
box on the LogOn screen.
IFT measurements can be
grouped into sets. Up to 6 sets
can be defined. This sets the
index number of the current set.
Increment the IFT set index (ID
number) by one.
Make an interfacial tension
measurement on the current
image in the Movie.

Variance: <value>

IFT measurement set

Index IFT set
Do IFT measurement

IFT set number (1..6): <index>
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Movie Analysis
Instruction

Parameters

Description

Spherical mode analysis

On=1, Off=0: <0 or 1>

Non-spherical mode
analysis

On=1, Off=0: <0 or 1>

Reflection image type
baseline

On=1, Off=0: <0 or 1>

Touch-off reflection
baseline

On=1, Off=0: <0 or 1>

Horizon image type
baseline

On=1, Off=0: <0 or 1>

Tilting baseline OK

On=1, Off=0: <0 or 1>

Turn on or off the Spherical
checkbox on the Contact Angle
tab. When checked, the
analysis will fit a portion of a
circle to the liquid-vapor profile.
This is the better fit for smaller
drops which are not distorted by
gravity.
Turn on or off the Non-spherical
checkbox on the Contact Angle
tab. When checked, the
analysis will fit polynomial curves
to the liquid-vapor interface, on
to each side.
Turn on or off the Reflection
Image Present checkbox on the
Contact Angle tab. A reflection
image is when you can see the
sample surface in front of the
drop and you can also see the
drop’s shadow or reflection, like
the reflection of the shoreline on
the surface of a small lake.
Turn on or off the Touch-Off
Reflection checkbox on the
Contact Angle tab. If checked,
the algorithm requires a full
Movie with the first frames
having the pendant drop above
the sample. The algorithm
determines the baseline location
by watching the reflection image
of the pendant drop as it comes
down to the surface.
Turn on or off the Use Horizon
checkbox on the Contact Angle
tab. A horizon image is when
the sample edge and the liquidsolid baseline are coincident, or
one on top of the other.
Turn on or off the Tilting
Baseline OK checkbox on the
Contact Angle tab. Most
baselines are horizontal and the
analysis will assume that unless
this box is checked.
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Movie Analysis
Instruction

Parameters

Description

Dispense tip in sessile
drop

On=1, Off=0: <0 or 1>

Upside down drop

On=1, Off=0: <0 or 1>

Complement measured
angle

On=1, Off=0: <0 or 1>

IF tension by pendant
drop

On=1, Off=0: <0 or 1>

IF tension by sessile
drop

On=1, Off=0: <0 or 1>

Dispense tip is tapered

On=1, Off=0: <0 or 1>

Turn on or off the Dispense Tip
in Drop checkbox on the Contact
Angle tab. If the tip stays in the
sessile drop, this must be
checked for the analysis to find
the profile correctly.
Turn on or off the Upside Down
Drop checkbox on the Contact
Angle tab. Normally off.
Turn on or off the Complement
Angle checkbox on the Contact
Angle tab. Typical use of this is
with air bubbles inside a liquid.
Turn on or off the IFT by
Pendant Drop checkbox on the
IFT tab. You must select one
IFT method from the list. This is
the normal choice.
Turn on or off the IFT by Sessile
Drop checkbox on the IFT tab.
You must select one IFT method
from the list.
Turn on or off the Tapered Tip
checkbox on the IFT tab. This
helps the analysis find the tip to
drop interfacial line.
Move to the first image in the
current Movie. This is the
normal starting point in a movie.
.This is necessary only if you
want to go back to the start after
moving forward.
Move to the next image in the
current Movie. If you are already
at the last image, you will simply
stay there.
Select one of three possible
surface energy calculations for
the same data. This lets you
use more than one model for the
same data.
Increment the surface energy set
number by one.
Transfer the current contact
angle data to a new row in the
angles table.
Transfer the current angles table
row to the current energies table
row for a subsequent surface
energy calculation.

Move to first image in
movie

Move to next image in
movie
Surface energy set

Index surface energy set
C.A. data to new angles
table row
Angles row to surface
energy set

Surface energy set number (1..3):
<1, 2, or 3)
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Movie Analysis
Instruction

Parameters

Description

Do surface energy
calculation

Index of surface energy method:
<index>

Select the desired method
(model) by its index number.
You can obtain this from the
drop down (pick) list on the
Surface Energy tab. Then click
the Calc button on the Surface
Energy tab. This makes the
calculation.
Delete the current image from
the Movie. You may select any
image by using Move First and
then Move Next.
Execute the previously selected
image processing function(s) on
the current image in the Movie.
If 1, save the current image as a
reference for a subsequent
image subtraction operation.
Enable the subtract reference
image function.
Enable the sharpen image
function. This makes edges
stand out better.
Enable the threshold image
(make it a black and white
silhouette) function.
Enable the smooth image
function. This reduces noise.
Enable the meniscus finder
function. The directions are
defined on the image processing
function tab: 0=down, 1-up,
2=left, 3=right.
Enable the aspect ratio function.
Save the current live image as
the reference image for a
subsequent subtraction. This is
an alternative to an image in the
Movie.

Delete image

Do Function on Image
Save Image as
Reference

On=1, Off=0: <0 or 1>

Subtract Reference
function
Sharpen image function

On=1, Off=0: <0 or 1>

Threshold image
function

On=1, Off=0: <0 or 1>

Smooth image function

On=1, Off=0: <0 or 1>

Meniscus image function

On=1, Off=0: <0 or 1>

On=1, Off=0: <0 or 1>

Direction (0...3): <0, 1, 2, or 3>
Aspect ratio function
Save Live image as
reference
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Instruction Listing: Names, Files, Databases
Names, Files, Databases
Instruction
Parameters
Run ID

Set Database name =
RunID

Save movies as

Save movies as: <file name>

Save BMP images

First suffix number: <index number>
JPG=2, BMP=1, Off=0: <0,1 or 2>

Name in movie

Sample name: <user text>

Make directory

Results directory: <path>

Make drive path

Results drive path: <path>

Liquids database

Liquids database: <path and filename>

Description
An input box will be presented to
operator into which a Run ID text
string can be entered. This will
be used to identify the set of
Movies captured by this
execution of the script.
Set Data Movie database name
= RunID + Sequencer program
name. This is a database, with
mdb extension, that holds
multiple Movie data. It holds no
images. It has been largely
replaced by cumulative XML files
which are enabled by a
checkbox on the LogOn screen.
Establish a base name and a
starting index for Movies to be
saved to disk upon their close.
If 1, save bmp images with the
same name as the Save Movies
As provides. Images are
indexed, independently of
Movies, with a suffix number.
Images are saved when the
Contact Angle measurement is
made. Each image in the Movie
will becomes a separate file. If
2, save as a jpg image.
This sample name is stored in
the Comments field of the Solids
database entry for this drop. If
the Solids database is not used,
this sample name has no effect.
Make a specific folder for data
results. This instruction can also
be executed by an external robot
over the serial line.
Make a specific path for data
results. This instruction can also
be executed by an external robot
over the serial line.
Complete path for an alternative
liquids database to the current
default database. Normally the
default is satisfactory. The
liquids database holds surface
tension data for standard test
liquids.
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Names, Files, Databases
Instruction
Parameters
Solids database

Solids database: <path and filename>

Kill SolidsDB

Open file Movies as

Open file movies as: <file name>
First suffix number: <number>

Open file Movie
Close file Movie

Description
Complete path for an alternative
solids database to the current
default database. Normally the
default is satisfactory. The
solids database holds contact
angle data for surface energy
calculations.
Delete the current solids
database file if it exists. This is
used when you want to
repeatedly use one solids
database name (for contact
angle data), but want to start
over with no data.
Establish a base name and a
starting index for subsequent
opening of Movies on disk.
These Movies may be analyzed
by the script.
Open the next Movie from disk.
Close the existing open Movie.
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Instruction Listing: Data Cells
Cells are groupings of contact angles, perhaps of drops of several liquids, that you wish to be
associated with a single spatial point on the sample, typically for surface energy analysis.
Data Cells
Instruction

Parameters

Begin cell

Cell number
Index cell number

Cell number: <index>

End cell
Plot R/X

Set R or X value for graph: <position>

Plot Q/Y

Set Q or Y value for graph: <position>

Index plot R/X
Index plot Q/Y

Description
Begin a new cell. A cell is a
group of drops to be considered
in one surface energy equation.
Typically each drop will be a
different test liquid.
The index (name) for this cell.
Increment the current cell index
by one.
Mates with a Begin cell
instruction to set the range of
measurements for this cell.
Cell data can be plotted as multidimensional point in an external
graph. This instruction sets the
radial (for cylindrical coordinates) or X (for Cartesian
coordinates) axis value for this
cell in the plot.
Cell data can be plotted as multidimensional point in an external
graph. This instruction sets the
theta (for cylindrical coordinates)
or Y (for Cartesian coordinates)
axis value for this cell in the plot.
Increment the plot R/X value by
one.
Increment the plot Q/Y value by
one.
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Instruction Listing: Chambers
These will be present only if you have a controlled enclosure or a chamber.
Chambers
Instruction

Parameters

Description

Temperature
measurement

On=1, Off=0: <0 or 1>

Humidity measurement

On=1, Off=0: <0 or 1>

Temperature controller
setpoint

Temperature control setpoint (deg):
<degrees>

Temperature control by
heater

On=1, Off=0: <0 or 1>

Chamber temp setpoint

Temperature control setpoint (deg):
<degrees>

Turn on or off the Temperature
Measurements checkbox. This
enables making temperature
measurements.
Turn on or off the Humidity
Measurements checkbox. This
enables making humidity
measurements.
Enter the temperature you wish
for the enclosure. Must be
above the ambient.
Turn on or off the Enable
Controller checkbox. This
enables power to the enclosure
heater.
FTA1000: Enter the setpoint
you wish for the main chamber
temperature. You can read the
actual temperature via User
Variable 120.
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Instruction Listing: User Variables and Macros
User Variables and Macros
Instruction
Parameters
Set User Variable value

User Variable number (1...200): <index>
Assign this value to User Variable:
<value>

Increment user variable

User Variable number (1...200): <index>

User Variable if then

Increment : <value>
User Variable number (1...200): <index>
If User Variable > : <test value>
Go to line number: <line number>

Get Live video black
level

Get Live video white
level

Description
User Variables are independent
variables that may be
manipulated and tested by the
script (i.e., the “user”). The
name of the variable is a number
specified by index. You may
assign any numeric value to the
variable. User Variables are
enumerated in a table at the end
of this section.
User Variables may be
incremented (changed) by any
amount.
Test a User Variable and branch
if the test is satisfied. The User
Variable must be greater than
(more positive than) the test
value. If this is true, branch to
the line number.
Get the black level (blackest
black) from the current Live
image and store in Last Data. It
will typically be a value between
0 and 100. Last Data is a
special User Variable that can be
tested with if/then statements.
Last Data can be store many
values, so it should be tested
immediately after being updated.
Use the Increment Live video
brightness instruction in Video
and Movie Capture to change
the video black level.
Get the white level (whitest
white) from the current Live
image and store in Last Data. It
will typically be a value between
150 and 255.
Use the Increment Live video
contrast instruction in Video and
Movie Capture to change the
video white level.
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User Variables and Macros
Instruction
Parameters
Get Live video
sharpness

Last Data if then

If Last Data > : <test value>

Position tip in image

Go to line number: <line number>
Tip Z below image top (pixels): <value>

Position stage in image

Stage Z above image bottom (pixels):
<value>

Dispense volume

Pendant volume (ul): <value>

Dispense to shape
(beta)

Pendant shape (beta): <value>

Find potential baseline

Description
Get sharpness from current Live
image. This will be a value
between 0 and 255, typically in
the 50 to 75 range. Sharpness
is primarily a function of focus,
but overall black to white level
range affects it also.
Test current value of Last Data
and, if test is satisfied, branch to
line number.
Run macro to position tip bottom
in image. Tip does not have to
be visible to start. Pixels are
measured down from top edge.
There are typically about 480
vertical pixels in image, so 50
pixels would be about 10%.
Run macro to position stagein
image. Stage does not have to
be visible to start. Final position
is measured in pixels up from
image bottom. A typical value
might be 50 to 100, or about 10
to 20% of image height.
Run macro to hang a pendant
drop of specified volume on tip.
Pump will either dispense of
aspirate to achieve target. A
tolerance is allowed so pump
does not oscillate back and forth
trying to correct a very small
amount.
Run macro to dispense a
pendant drop so that a specific
shape is reached. Beta refers to
a Laplace-Young analysis
parameter. A beta of 0 is a
perfect circle. A typical pendant
drop will have a beta of -0.20.
Run macro to lower tip close to
surface to ascertain surface
location using image analysis.
Surface location is stored as a
potential baseline location,
assuming drop is deposited
below tip. You can use this
proposed baseline with the
Contact angle baseline
instruction and no values given
(see this instruction in Movie
Analysis).
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User Variables and Macros
Instruction
Parameters
Touch off drop

Extra down motion (mm): <value>

Move Tip Z to target

Bias above image target (mm): <value>

Center tip in image
Capture reference image

Macros use ref image

On=1, Off=0: <0 or 1>

Description
Run macro to deposit a hanging
drop on the surface. Tip will be
lowered until pendant drop
touches surface. Extra distance
is the further motion allowed to
ensure drop attaches to surface.
Move the tip until its bottom is at
the surface + any bias value
specified. This is useful for
aspirating liquid back off the
surface. You must have
determined the “target” value
earlier using Find potential
baseline.
Run macro to center the tip in
the image. Tip must be visible.
This is used when the Live
image is present. It will capture
and hold the current view for
later image background
subtraction within a macro. To
be useful, the Live image will
typically not show the tip and
drop – instead it will show
background objects or artifacts
that you wish to have removed
from consideration by the
subsequent image processing.
When “1” and when a reference
image is available, the reference
image will be subtracted from the
current image before use by the
macro.

Special Note on Macros
With the exception of Position tip in image and Position stage in image, macros require the tip to be
present in the image when the macro starts. If there is no tip, the macro will end immediately and report
an error in Last Data. This is necessary because these other macros need to move the tip and they
would not know where to start with the tip visible.
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Last Data Assignments
The following values will be assigned to the User Variable Last Data.
There is only one location for Last Data, so it will contain the most recent assignment.
Example: if the last instruction was a macro, Last Data will contain the macro’s return code, but if the last
instruction was a contact angle measurement, then Last Data will be an angle.
Error return code from any macro. 0=success. Other values encode possible failures. Non-zero codes
are normally output to the Sequencer event log. Some common codes:
0 = success
1 = no image
2 = stopped by user
3 = general image error, typically low contrast or interference
4 = no tip could be found in image
5 = spare
6 = drop fell off tip
7 = too many pump moves for small drop (<2ul)
8 = too many pump moves for large drop (>2ul)
9 = too many tip Z moves
10 = too many stage Z moves
Contact angle (last angle measured)
Interfacial tension (last IFT measured)
Black level of Live image (from contrast measurement)
White level of Live image (from contrast measurement)
Sharpness of Live image (from contrast measurement)

How to Test Last Data and User Variables
You can test and branch in your script based on the current value of Last Data or any User Variable.
Use Last data if then to test Last Data. If Last Data is greater than the comparison value you furnish, the
instruction will branch (go to) the line number you specify. If the test is not true (Last Data is equal or
smaller than your test value), the script will continue on to the next instruction.
Use User variable if then to similarly test the current value of a user variable you specify against your
test value. If the test is satisfied, the script will branch to the line number you specify.
You can build a compound test to find out if the test variable (Last Data or your chosen user variable) is
within some range. You will need two sequential if then tests. As an example, say you want to find out if
Last Data is between 3 and 5. Assume Last Data is an integer. The script segment will look like
1000
1010
1020
1050
1100
1200

Last data if then
Last data if then
Go to line
your instruction
your instruction
your instruction

5, 1100
2, 1050
1200

if greater than 5, goto 1100 and continue script
if greater than 2, as 3 would be, you are between 3 and 5
got here because 2 or less
case of between 3 and 5
case of greater than 5
case of less than 3
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User Variables
User Variables are identified by their Index, a numeric name.
You must explicitly execute some instruction to assign values to User Variables.
Index
1...100

Description
General purpose numeric variables assigned by user

101

Black level in image

102

White level in image

103

Sharpness (similar to focus) value of image

104

Contact angle

105

Left side contact angle

106

Right side contact angle

107

Sessile drop volume

108

Sessile base width (diameter)

109

Sessile drop height

110

Drop baseline tilt angle

111

Instrument tilt angle

112

Tip width (diameter)

113

Interfacial tension

114

Pendant drop volume

115

Pendant drop surface area

116

Pendant drop major diameter

117

Laplace-Young radius at apex

118

Laplace-Young beta

119

Laplace-Young RMS drop profile fit error

120

Measured temperature in chamber

465 Dinwiddie Street • Portsmouth, Virginia 23704 • 1.757.393.1584 Fax: 1.757.393.3708
http://www.firsttenangstroms.com

41

Frequently Asked Questions
1.If you do not see the Sequencer tab in Analysis on the Video window, make sure the
hardware you selected on the LogOn screen supports the Sequencer. The FTA1000 and
FTA2000 do support it.
2.If the script “crashes”, use Single Step mode to determine when some strangeness first
appears. Inspect that carefully. The fault that starts here may not be fatal until several steps
later.
3.See the FTA website for examples of Sequencer programs. One link is
http://www.firsttenangstroms.com/pdfdocs/SequencerExamples.pdf
4.See the FTA website for updated FAQ's discussing problems and solutions. For example:
http://www.firsttenangstroms.com/faq/DebuggingSequencerPrograms.html
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